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QUILTING FOR LIFE

Information Systems and Services
 is home to a celebrity!

Elizabeth Settle was recently spotlighted in both The Elyria Chronicle Telegram
and The Lorain Morning Journal just for doing something she loves to do -
making a quilt.  But her quilt is a very special one, because it commemorates the
life-saving properties of donating blood.  Liz used some T-shirts she received when
she gave blood and some that she received as donations from LifeShare, the blood
bank of Lorain County.  After taking a T-shirt quilting class at Quilts and Kreations
in South Amherst, she put her first quilt together very quickly.  So far, Liz has made
two LifeShare quilts and is working on a third.

Liz was inspired to make the quilts, because her life was saved by blood donors
during a medical crisis at the birth of her second child.  Without the blood donors
who made her transfusion possible, she would not be here, so she decided to give
back something to the organization that helped to save her life. Liz says that “this
(the quilt-making) was really a part of my healing process.”  It didn’t help her to
forget about the past, but she says that now “I don’t need to be scared of it.”  Her
husband, Jonathon, supports her hobby and encourages her to be creative.
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Liz’s quilts were displayed at the recent “Thanks-4-
Giving” Blood Drive and Public Education Forum that
was held at the Spitzer Conference Center in November.
There was food, entertainment, massages (for donors),
prizes, and exhibitors all under one roof.  The college is
always hosting a blood drive in the CC Mall, but the one
at Spitzer is the big annual affair that brings people out to
donate blood. Liz has since recovered from her ordeal
and is quickly working to finish the third quilt.

MEET YOUR STAFF COUNCIL
REPRESENTATIVE
by Barb Armstrong

Gina Maxwell is the Staff Council Executive Committee
Representative for Group 12.  When she is not being a
representative,
she is working in
Health Physical
Education and
Recreation as an
Administrative
Associate.  Gina
feels that the role
of SCEC is to
“represent the
LCCC staff
community in
various college
initiatives and
provide an
opportunity for
concerns and/or
ideas to be shared
and addressed.”
She was elected in 2007 and her term will end in two
years.  On a more personal note, Gina has been employed
here at the college for over 15 years.  She met her husband,
Steve, at LCCC and their son attended the Early
Childhood Education Lab School and the summer daycare
program. So when she says that “LCCC feels like home
to me,” she really means it!  Gina received her Associate
of Arts Degree in 1990 and has been a volunteer at yearly
events, such as the Student Life Campus Picnic, Family
Fest, and SCEC Spring Break. Her priority in SCEC is
“to represent the concerns and ideas of my constituents
of Group 12.”  You can reach her in the HPER office,
PE104, at extension 7598, or at her email address
(rmaxwell@lorainccc.edu).

QUESTION OF THE MONTH
Compiled by Peggy Nesbit

Are you planning on traveling for the holidays and, if so,
where?

My husband and I are going to travel just prior to
Christmas.  Our oldest daughter lives in Arlington, TX
and is waiting for a new baby daughter to be born any
day now.  The minute we hear anything...we’ll jump in
the car and spend a week or so with Cheri and her
husband, and the baby’s three year old brother Clyde.
Rita C. Pullen, Business Division

I am going to Houston, Texas to visit my daughter, son-
in-law, and the three grandsons.  I go every year after
Christmas Day and stay through the New Year Holiday.
Barb Armstrong, IS&S

Traditionally, every December 31st, my husband, son, I
and our two dogs hold a slumber party in the living room.
The five of us drag out our sleeping bags (Max and Daisy
prefer their beds), a selection of DVD’s, a variety of
munchies, and wine and/or grape juice to toast in the New
Year.   We don’t have to go out into the cold.  We can just
sit back, relax and enjoy each others company.
Mary Karleskint, Faculty Senate Office

My husband & I are planning a trip to Blairsville, PA.  It
may not be a long distance, but when we are away from
our children it may as well be across the world.
Lynne Mendlik, Business Division

I’m going to Bergen in Norway.
Kwaku Obosu-Mensah, Social Sciences/Human
Services Division

I will be going to England for Christmas. My wife (who
is from England) and I will be spending just under 4 weeks
there.
Adam Loring, Campus Services

This year Steve and I took two weeks off. We are planning
on driving to Denver, Colorado for Christmas to visit a
friend for a few days and New Year’s in Texas with
another friend. It will be cool as I had never been in
Denver before. Lots of driving.

Usually we have Christmas Eve with my parents here in
Lorain and spend Christmas Day with Steve’s family in
Ashtabula but this year we wanted to do something
different.
Diane Nott, IS&S
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Computer Tips
Submitted by Diane Nott

Don’t Print the Whole File!
Have you ever accidently printed out that big file when
you only wanted one or two pages? Have you ever found
yourself trying to print only a few pages of a long file?
Maybe you only made changes to one page and you just
need that one, not the other 42.
Sound like a familiar situation? If your answer is yes,
here’s the solution to your problems!
The next time you go to print your project and you only
need a portion of the file, use either the File menu, Print
choice (Office Button, Print choice in Word 2007) or
Ctrl + P in all versions. (The printer button usually just
prints the whole file, with no options, so using that won’t
help you here). Now, take a good look at the Print window.
See the section on the left, in the bottom/middle area?

Maybe you do have an option after all!
By default, the All choice is selected.
• To only print the page that currently contains the cursor,
select Current Page and then click OK.
• To print an already highlighted section of the document,
choose the Selection option and click OK.
• To print several non-consecutive pages, select the
Pages option and list the page numbers, separated
by commas in the field. For example, to print pages
one, three and seven, you would type 1, 3, 7 in the Pages
field and then click OK.

DECEMBER HOLIDAYS

National Poinsettia Day is December 12.  It was declared
so by Congress in the mid 1800’s to honor Joel Roberts
Poinsett who was the first U. S. ambassador to Mexico.
He brought the flowering plant back to his plantation in
1828, where he started growing them to give as gifts for
the Holiday season.  According to Mexican folklore, a
poor little girl had nothing to bring to Church on Christmas,
so she picked some plants that grew by the side of the
road.  When she got to the Church, the leaves miraculously
turned red and the poinsettia was born.  Today the
poinsettia is mainly grown in California, with a whopping
27 million pots grown each year.

National Cotton Candy Day is December 7.  No one is
really sure who invented cotton candy.  John Wharton
and William Morrison created the first cotton candy
machine which they took to the World’s Fair in 1904.
However, in 1900 Thomas Patton used a gas-fired rotating
plate to spin cotton candy threads, which he introduced
at the Ringly Brothers Circus.  In 1949 a more reliable
cotton candy machine helped to make this candy a favorite
summer time treat.  Cotton candy was originally called
fairy floss and contains only one ingredient - sugar.

Posadas Week is December 16-24.  In Mexico, Posadas
is a very popular event.  It is celebrated in villages during
the week before Christmas by getting together at a
different home every night.  The people of the village are
led by a small child dressed as an angel.  The child leads
the group to the house where the party is being held that
night.  Half the group goes inside, the other half stays out
and begs for shelter (posada means shelter or lodging in
Spanish).  This procession symbolizes Mary and Joseph
asking for lodging in Bethlehem.  The group is brought
inside and the party begins with plenty of food and drink.
A piñata shaped like a star is the highlight of the party for
the children.

• To print a range of pages, select the Pages option and
type the first page to be printed, then a hyphen
and then the last page to be printed in the field. For
example, to print pages two through seven, you would
type 2-7 in the Pages field and then click OK.
• The Page field box will also let you mix the non-
consecutive method with the range of pages. For example,
to print pages three, seven though nine and 12, simply
type 3, 7-9, 12 in the Pages field and click OK.

Voila! Print what you want and only what you want.
Source: worldstart.com
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QUICK MOVIE REVIEW
by Barb Armstrong

August Rush: Once again, I only had time to see one
movie, but this is the movie to see this holiday season,
if you are picking one.
The story is about a young orphan boy, played by Freddie
Highmore, who lives in an orphanage and has an incredible
talent for music, even though he has never played an
instrument in his life. August, prompted by music that he
constantly hears in his mind, runs away from the orphanage
and joins a gang of young homeless children who live in
an abandoned theater.  They panhandle on the streets of
New York City and bring the money back to their Fagin-
like benefactor called Wizard, played by Robin Williams.
Wizard is the one who christens the boy August Rush
and makes the young orphan his star performer on the
streets of New York. Luck catches up with August and
he is discovered, sent to the Julliard School of Music and
is preparing to conduct his first rhapsody with the school
orchestra.  This is one story line.  The other story line in
the movie is about his mother, Lyla Novacek, played by
Keri Russell.  She is a concert cellist and travels the world
with her father whose only job is to promote his daughter
in as many musical performances as possible.  She meets
a young rock star from Ireland, Louis Connelly, played
by Jonathon Rhys Meyers.  They instantly fall in love
and Lyla finds that she is pregnant.  Obligations tear them
away from each other and they eventually lead their
separate, but lonely lives.  Just about the time of her
delivery, she is involved in a car accident and finds herself
in the hospital, where her father, deeming it in her best
interest, tells her the baby died.  After that the story deals
with the sometimes eerie pull that the three of them have
on each other, musically speaking.
Note:  A very good family movie with a great ending.

Wacky WeView
by Paul and Barb

Here are some Holiday jokes to help get you in a
cheerful mood for the season.

What do reindeer always say before telling you a joke?
This one will “sleigh” you.
What do you get when you cross an archer with a gift
wrapper?
Ribbon Hood.
What’s red and white and gives presents to gazelles?
Santelope.
What kind of pine has the sharpest needles?
A porcupine.
What happened when Santa’s cat swallowed a ball of
yarn?
She had mittens.

Barb:  Not yarn balls?
Who is never hungry at Christmas?
The turkey - he’s always stuffed.
What is the elves favorite ride at Disney World?
It’s a Small World.
What do reindeer hang on their Christmas trees?
Horn-aments.
Who sings “Blue Christmas” and makes toy guitars?
Elfis.

Groan!
What do you give a reindeer with an upset stomach?
Elk-a-seltzer.
What do you call Santa’s helpers?
Subordinate Clauses.

Barb: I’ve heard that one before!
Paul:  Aren’t you sorry you started this?

What do snowmen wear on their heads?
Ice caps.
What’s the first thing elves learn in school?
The elf-abet.
Where do snowmen go to dance?
Snowballs.
If athletes get athletes foot, what do astronauts get?
Missletoe.

Barb: Are we almost done?
Paul: I’ve got lots more.

What do you get if you cross an apple with a Christmas
tree?
A pineapple.
What did the guest sing at the Eskimo’s Christmas party?
Freeze a jolly good fellow.
Why were Santa’s helpers depressed?
Because they had low elf esteem.

And finally a thought to get you through the
holidays:

STRESSED is simply
DESSERTS spelled backward.
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Four Quick Tips for Trimming Down Your
Outlook Mailbox

submitted by Larry O’Grady, IS&S

Tip 1: Empty the Deleted Items folder
• Use the Empty the Deleted Items folder

upon exiting setting to automatically delete
messages. (To get to this check box, click
Options on the Tools menu and click the
Other tab.)

• Select the check box for Empty the Deleted
Items folder upon exiting and click Apply

Every time you delete an e-mail message, it goes into
the Deleted Items folder. This folder can grow
quickly, so you need to keep cleaning it out. Since you
probably intended to get rid of deleted items in the first
place, permanently tossing them out is a painless way
to cut the bulk.
You can specify when and how you want your
Deleted Items folder tidied up: You can tidy up
automatically every time you quit Outlook, or do it
manually whenever you like.
Tidy automatically - Select a check box, as described
above, and your mailbox will be trimmer in no time.
Tidy manually - If you prefer to have more control over
when items are dumped from Deleted Items, you can
empty the Deleted Items folder manually with a simple
right-click on the Deleted Items folder and then Empty
“Deleted Items” folder, or you can use the Mailbox
Cleanup dialog box. Are you noticing a pattern for this
Mailbox Cleanup tool? It’s a great resource for cleaning
things up

Tip 2: Save attachments outside the mailbox
• Save attachments to a location outside your

mailbox by clicking the Save Attachments
command on the File menu. This command is
available when you have an e-mail message
open.

Attachments can take up a lot of space. If you don’t
need to store them in your mailbox, don’t. Instead, use
the Save Attachment command on the File menu and
save the attachments to some convenient location on
your hard disk. Once you’ve saved the attachment, you
can delete the message (if you don’t need it anymore)
or you can right-click the attachment icon and click
Remove to keep the message but remove the
attachment.

Tip 3: Archive the Sent Items folder regularly
• Archive messages that are stored in the Sent

Items folder regularly.

Tip 4: No response is the best response
• Don’t respond to unsolicited e-mail messages.

Throw them away.

Don’t respond to junk messages or chain letters. Also,
don’t click links within this type of e-mail that say
things such as “Click here to remove yourself from this
mailing list.” When you respond or click these “remove
me” links, you’re letting the sender know that there’s
someone at home at your e-mail address, and you’re
likely to encourage more of this type of junk e-mail.

Fish RecallFish RecallFish RecallFish RecallFish Recall
The fishes have swum their last
river…..Could all fish please swim
home with the name of the last person
who had it attached to it, so that
person can get credit?  Staff
Council will then be permanently
awarding the fish to the people who
had the fish the most times to
recognize their outstanding qualities.
Everyone can return the fish to
CC010K (the Staff Council
Office) after 2:30 p.m. or bring them
to Judy DeMarino in UC107 from
9:00 – 2:30 pm by December 21.
Thank you everyone for your
cooperation during Staff Council
Executive Committee’s Fish
Campaign.
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You’ll Shoot Your Eye Out!
Submitted by Richard Pasky

Ah yes, the immortal line from the holiday classic A Christmas Story,
filmed in Cleveland.  Well, it seems that I had a wish for a similar gun,
only recently.  My favorite toy as a pre-teen was a Mattel Burp
Gun.  This marvelous weapon of mass (pretend) destruction is a cap
gun that will shoot an entire roll of caps in a single burst of noise and
stinky smoke.  I simply loved it. The toy burp gun replicated the
“grease gun” machine gun (officially the M3) used in WWII. (A vet
friend recently told me that the real M3 grease guns used in Vietnam
had Mattel labels on the housings, something the GIs thought was
pretty funny.)
To appeal to all boys in the mid 1950’s, Mattel developed several
models of machine gun toys.  One was patterned after the Thompson
submachine gun, affectionately nicknamed the Tommy gun, and
another was called the Thunder gun which made thunderous noises,
but did not shoot caps. The Tommy gun was only available with a
crank, like in Jack-in-the-boxes and cranking didn’t appeal to me.
My old burp gun had a windup spring that allowed me to pull the
trigger quickly for single shots, or hold it to peel off a whole roll of
caps. What a great toy it was! If only they were available now, for
my second childhood, AKA retirement!
Over the past three years in my eBay search for the Burp Gun, I’ve
been outbid maybe 6 times, not including one “never used” (from
Put-in-Bay of all places) which was in the original box and had an
asking opening bid of $250.  I never even tried for that one. I learned
there was a crank model of my gun, as well as a model with a stubby
stock, similar to the Uzi used today in action movies. This summer I
eventually found an Uzi model needing some repairs.  Even though it
wasn’t my exact model, I went for it and won, bidding only $52.
Most of the windup grease gun models with wire stocks went for
well over $100.  Maybe this winter I’ll get around to working on it so
it will actually shoot real caps.

About 5 years ago, I discovered eBay
after scrounging garage sales in search
of old Golden Nature Guide books
from the 1950s. I still owned my
childhood 160-page copies of Trees,
Birds, and Mammals.  I discovered
that there were many others, after
seeing several at garage sales and my
book collecting began in earnest.
After doing some online research, I
learned that there were 84 different
Golden Guides published up into the
1980s! I was flabbergasted, but
decided I needed all of them. A cool
website, http://
www.vintagepbks.com, has a list with
photos of every guide, as well as some
great, cheesy pulp fiction covers from
the 40s-60s.

On any given day, 100-150 Golden
Guides are for sale on eBay.  Over
the years I slowly completed my
collection, ending in 2006 with the
acquisition of the Holy Grail – The
Golden Travel Guide to Italy from
1955. I had been outbid on this one
in last-second frenzies more than once,
but finally went “all in” to win, so to
speak. Another famous Golden Guide
is Hallucinogenic Plants which is less
costly than the Italy guide but has been
removed from school libraries over
the years for obvious reasons.  I have
also supplemented my beer label
collection from eBay, winning some
now-extinct Old Dutch labels. I also
have unsuccessfully tried to buy a mint
condition 1950s Nokona 1st

baseman’s mitt that I used in Little
League.  Everyone can find a lot of
childhood memories on eBay that you
thought were gone forever.
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NaNoWriMo? Or 50,000 Words in 30 Days
Submitted by Peggy Nesbit

I have always loved stories, listening to them from relatives,
making them up while playing with dolls and stuffed
animals, or reading them. For a kid with dyslexia and a
serious lag in learning to read, I didn’t really realize that
what I really wanted to do was write stories until I was in
about 5th grade. My goal in life is to write novels and get
them published. I love working in the Bookstore but I
love writing even more and I’ve been trying to get through
a novel since grade school.
But sometimes life seems to get in the way. Though I
have boxes of story ideas and half-written work, beyond
a few short stories done for classes, I’ve not really ever
finished anything that I felt comfortable sending to an
editor or agent. Call me a chicken but anyone who creates
knows there’s a monster called failure and his brother
rejection just waiting to pounce on you. Scary stuff!
Last year my nephew (also an aspiring novelist) told me
about this website that hosts a writing contest every
November. A guy in Oakland, CA named Chris Baty came
up with the idea of challenging writers all over the word
to write 50,000 words (approx. 175 typed pages) from
Nov. 1 through midnight Nov. 30. He began the National
Novel Writing Month (NaNoWriMo) in 1999 in the San
Fransicso Bay area and it’s only grown since then.
This year over 100,000 writers in over 70 countries,
including myself, started writing a novel on November 1.
I chose to write a fantasy ala Ursula LeGuin, Anne
McCaffrey and Sharon Shinn but had a number of story
ideas from a variety of genres—mystery, science fiction,
paranormal, romance, historical—from which to choose.
I started out slow and only had 13,000 words by the middle
of the month. But by 8:30 p.m. November 30, I submitted
my manuscript to the website’s word counter and had a
total of 50,480 words of a novel! I was/am a winner!!
As of December 1, there were 15,334 “winners” who
had written over 50K words. Between all the participants,
1,187,931,929 words were written during the month.
What’s the point of writing 50,000 words besides wearing
out your keyboard? Lots of writers get bogged down
worrying about every little word and trying to write a
perfect first draft—all of which would discourage anyone
since nothing is ever perfect the first time around. By
giving yourself permission to just write and by forcing
yourself to keep going, you can just let go and not worry
about whether an idea you have on page 57 should have
been brought up much earlier (foreshadowing) because

you haven’t got the time to go back and fix it. You just
accept that you’ll catch it in the second—or third or
fourth—draft.
Did I finish the novel in 50K words? No, it’s about 2/3rds
of the way done. Will I continue to work on it? You bet.
I’ve learned that sometimes just “going” is as important
as ever “getting there.”
If you are interested in learning more about NaNoWriMo got
to www.NaNoWriMo.org.

Snow Season Reminder
Submitted by Bob Flyer, Director

Physical Plant Services
With winter rapidly approaching we thought we’d send a
friendly reminder:
 When driving on campus, walking through parking lots,
between buildings or walking or running on the loop roads,
be aware of snow plows or other snow removal equipment
especially when dark. Also please slow down a little to
avoid accidents.
When walking or running the loop road, please always
wear highly visible and reflective clothing regardless of
the season. When walking wear boots, shoe covers or
non slip shoes. We do our very best to remove snow
from approx. 5 miles of roads and sidewalks and over
4,000 parking spaces.
Please don’t leave cars parked over night unless working.
They make snow removal in parking lots difficult.
Thanks and enjoy the winter.

New Books from Campus Authors
& Local Interest Gifts

Bobbi Holliday (HPER) has a new book entitled
Archives of My Soul: Poems, Metaphysical
Meditations, Prayer and Reflections for $39.95.
Dr. George Vourlojianis (SS/HS) has a new book entitled
Citizen Soldiers: 107th Cavalry Regiment, Ohio
National Guard for $16.50.
Carol Cornett (ITMS) of the Cuyahoga Valley Trails
Council recommends the Trail Guide Cuyahoga Valley
National Park for $15.95.
The Lorain County Sacred Landmarks Initiative is selling
note card four-packs of local stained glass windows
for $5/pack. Also available are posters of local sacred
architecture.

All are available at the LCCC Bookstore.
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Tuna, Asparagus and Feta Salad
submitted by Marjorie Martinez-Benson

This delicious salad provides about 3 portions of
vegetables - a generous start on the daily recommendation
of 5-7.
Ingredients:
2 cups romaine lettuce torn into pieces
1 Roma tomato, cut into 8 pieces
1/2 cup steamed asparagus pieces
1/2 can (3 ounces) white albacore tuna, drained
1 ounce feta cheese, crumbled
1/2 tablespoon extra-virgin olive oil
1 tablespoon balsamic vinegar

Mix the romaine, tomato and asparagus. Add the tuna
and feta cheese. Sprinkle with the olive oil and toss to
coat. Add the balsamic vinegar and toss again. Serves 1.

Sausage & Cheese Rounds
Submitted by Peggy Nesbit
This is one from my college days that I had thought I’d
lost, instead I’d given it to my mother.

1 pound ground chuck beef
1 pound bulk hot sausage (or regular)
1 pound Velveeta cheese
1 tablespoon oregano, dried
1 tablespoon black pepper
1 T. garlic salt
2 loaves cocktail rye bread

Brown the ground beef and sausage (drain, if needed.)
Cut up cheese and add to meat. Add spices and stir until
cheese is melted and everything is mixed well. Spread
about a teaspoon onto a slice of cocktail rye. Bake in a
350 degree oven until topping is bubbly and serve hot.

Lemon Raspberry Cheesecake Squares
Submitted by Peggy Nesbit
Crust:
¾ cup butter-flavored Crisco shortening
½ cup brown sugar, firmly packed
1 ¼ cups all-purpose flour
1 c. uncooked quick or old-fashioned oats
¼ teaspoon salt

Filling:
1 12-ounce jar Seedless Red Raspberry jam
2 8-ounce packages cream cheese, softened
¾ cup sugar
2 tablespoons all-purpose flour
2 eggs
3 tablespoons lemon juice
2 teaspoons lemon peel

Preheat over to 350 degrees. Grease 9x13-inch baking
dish with Crisco and set aside. For crust, beat Crisco
shortening and brown sugar together until smooth. Mix
together flour, oats, and salt then add slowly to shortening
mixture, beating until smooth. Press into the bottom of
pan and bake for 20 minutes or until evenly brown.
Remove from oven and immediately spread jam over hot
crust. For filling, beat together cream cheese, sugar and
flour until smooth then add one egg at a time. Add lemon
peel and juice and beat until well blended. Pour mixture
over jam crust and bake for 25 minutes or until set.

Cherry Squares
Submitted by Lisa Hearn
1 cup butter (2 sticks)
1 cup sugar
1 teaspoon vanilla
2 eggs
2 cups all-purpose flour
1 cup nuts, chopped (pecans or walnuts)
2 21-ounce cans of cherry pie filling (or 1 can)

Preheat oven to 350 degrees. Combine all ingredients but
cherries. Press 3/4th of batter into bottom of 9x13" baking
pan. Spread cherries on top. Drop spoonfuls of remaining
batter on top of the cherries. Bake for 45 minutes or until
top batter drops are golden brown.

Christmas Pudding-English Tradition
Christmas pudding is a steamed pudding, heavy with
dried fruit and nuts, and usually made with suet. It is
very dark in appearance - effectively black - as a
result of the dark sugars and black treacle in most
recipes, and the long cooking. The mixture can be
moistened with the juice of citrus fruits, brandy and
other alcohol (some recipes call for dark beers such
as mild, stout or porter).
Source: Wikipedia.com


